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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 2740p Tablet PC

Processors Intel® Core™i7 processors, Dual Core (soldered to system board)

 620M, 2.66-GHz processor, 4-MB L3 cache

 Intel Core i5 processors, Dual Core (soldered to system board)

 540M, 2.53-GHz processor, 3-MB L3 cache

 520M, 2.40-GHz processor, 3-MB L3 cache

Chipset Mobile Intel QM57 Express Chipset

Graphics Intel Graphics Media Accelerator HD

 Integrated with shared video memory

 Supports dual-display ports through the dock

Panel 30.7-cm (12.1-in) Illumi-Lite WXGA UWVA (1280x800)

 30.7-cm (12.1-in) Illumi-Lite WXGA UWVA outdoor view (1280x800) with digitizer and/or
multi-touch

 Chemically-strengthened glass top cover

Memory Two customer-accessible/upgradeable memory module slots

 Supports dual-channel memory

 Supports up to 8 GB of PC3-10600, 1333-MHz, DDR3 system RAM (running at 1066 MHz)

 Supports the following configurations:

● 8192 (4096 × 2)

● 6144 (4096 + 2048)

● 4096 (2048 × 2)

● 4096 (4096 × 1)

● 3072 (2048 + 1024)

● 2048 (2048 × 1)

Hard drives Supports 4.57-cm (1.80-in) SATA hard drives

 Customer-accessible
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Category Description

 Supports the following drives:

● 250-GB hard drive

● 160-GB hard drive

● 160-GB solid-state drive

● 80-GB solid-state drive

Audio/Visual Integrated dual-array microphone

 HD audio

 Stereo speakers (2)

 Integrated 2-megapixel webcam with business card reader software

Modem 56K V.92 MDC data/fax modem

 Modem cable not included

 Supports “No Modem” option

Ethernet Intel 82577LM GbE LAN 10/100/1000 network interface card (NIC) with iAMT

 S3/S4/S5 wake on LAN

 NIC power down technology

 Ethernet cable not included

Wireless Integrated WLAN options by way of wireless module:

 Two WLAN antennas built into display assembly

 Supports “no WLAN” option

 Supports the following WLAN formats:

● Broadcom BCM4312 802.11/b/g

● Broadcom 4322 AGN 802.11a/b/g/draft-n

● Intel Centrino® Advanced-N 6200 ABG

● Intel Centrino Advanced-N 6200 AGN

 Integrated WWAN options by way of wireless module:

 Two WLAN antennas (world-wide 5-band) built into display assembly

 GPS support

 Subscriber identity module (SIM) security (customer-accessible in battery bay)

 Integrated personal area network (PAN) options by way of Bluetooth® module:

 Supports “no PAN” option

 Broadcom Bluetooth

External media card ExpressCard 34 mm

 SD Card Reader supporting MultiMediaCard (MMC) and Secure Digital (SD) Memory Cards

Ports Audio-in (stereo microphone)
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Category Description

 Audio-out (stereo headphone)

 RJ-11 (modem)

 RJ-45 (Ethernet, includes link and activity lights)

 USB 2.0 (3), one powered

 VGA (Dsub 15-pin)

 1394a

 Multipin AC power

 Docking connector

Docking HP 2740 Ultra-Slim Expansion Base (specific to computer)

Keyboard Full-size keyboard

 Dual point

 Spill-resistant design, DuraKey coating

 Touchpad supports 2-way scroll with legend

 Digital eraser pen with tether

Power requirements 65-watt Smart AC adapter with localized cable plug support (3-wire plug with ground pin):

 6-cell, 44-Wh Li-ion battery with fuel gauge LEDs

 6-cell, 39-Wh Li-ion battery (only with 3 year warranties)

 Supports optional HP2700 Ultra-Slim Battery

 HP Fast Charge Technology

Security Integrated fingerprint reader

 Integrated smart card reader

 Kensington Security Lock

 Trusted platform module (TPM) V.1.2

 Preboot authentication (password, smart card)

 HP ProtectTools, HP Power Assistant, HP SkyRoom

Operating system Preinstalled:

 Windows 7 Professional 64

 Windows 7 Professional 32

 Windows 7 Professional with XPT images

 Windows Vista Business 32

 FreeDOS

 Preinstalled with Microsoft® Office:

 Windows 7 Professional 32 or 64 with Microsoft® Office 2007 Personal with Powerpoint

 Windows 7 Professional 32 or 64 with Microsoft Office 2007 Personal
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Category Description

 Windows 7 Professional 32 or 64 with Microsoft Office 2007 Professional

 Windows 7 Professional 32 or 64 with Microsoft Office 2007 Ready

 Windows 7 Professional with XPT images with Microsoft Office Ready

 Windows 7 Professional with XPT images with Microsoft Office Personal

 Windows 7 Professional with XPT images with Microsoft Office Personal with Powerpoint

 Windows 7 Professional with XPT images with Microsoft Office Professional

 Windows Vista Business 32 with Microsoft Office 2007 Ready

 Windows Vista Business 32 with Microsoft Office 2007 Personal with Powerpoint

 Windows Vista Business 32 with Microsoft Office 2007 Personal

 Windows Vista Business 32 with Microsoft 2007 Professional

Restore Media:

 Windows 7 Professional 32 or 64

 Windows Vista Business 32

 Windows XP Tablet

 Microsoft Office 2007 Ready

 DRDVD Vista

 DRDVD Windows XP Tablet

 DRDVD Windows 7

 Web-only support:

 Windows Vista Enterprise 32 or 64

 Windows 7 Home Premium

 Certified:

 Microsoft WHQL

 SuSE Linux
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2 External component identification

Display

Component Description

(1) Webcam light On: The webcam is in use.

(2) Webcam Records audio and video and captures still photographs.

(3) Keyboard light button Opens and turns on the keyboard light.

(4) HP Fingerprint Sensor Allows a fingerprint logon to Windows instead of a password logon.

(5) Internal microphones (2) Record sound and transmit sound for video conferencing and Voice
over IP (VoIP).

(6) Ambient light sensor Automatically adjusts the display brightness based on the lighting
conditions in your environment.

(7 ) Convertible hinge Swivels the display and converts the computer from traditional
notebook mode into tablet mode or vice versa.

(8) Touch screen Allows you to perform certain actions on the screen using your fingers.
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Top components
Pointing devices

Component Description

(1) TouchPad light ● Off: TouchPad is enabled.

● Amber: TouchPad is disabled.

(2) TouchPad on/off control Enables/disables the TouchPad when pressed in combination
with the fn key.

(3) Pointing stick* Moves the pointer and selects or activates items on the screen.

(4) fn key Enables/disables the TouchPad when pressed in combination
with the f5 key.

(5) Left pointing stick button* Functions like the left button on an external mouse.

(6) TouchPad* Moves the pointer and selects or activates items on the screen.

(7) Left TouchPad button* Functions like the left button on an external mouse.

(8) Right TouchPad button* Functions like the right button on an external mouse.

(9) TouchPad scroll zone Scrolls up or down.

(10) Right pointing stick button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

● In Windows 7, select Start > Devices and Printers. Then right-click the device representing your computer, and select
Mouse Settings.

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Lights

Component Description

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2) Battery light ● Amber: A battery is charging.

● Turquoise: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(3) Drive light ● Blinking turquoise: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

(4) Caps lock light On: Caps lock is on.

(5) TouchPad light ● Off: TouchPad is enabled.

● Amber: TouchPad is disabled.

(6) Volume mute light ● Turquoise: Computer sound is on.

● Amber: Computer sound is off.

(7) Volume down light Blinking: The volume down button is being used to decrease
speaker volume.
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Component Description

(8) Volume up light Blinking: The volume up button is being used to increase speaker
volume.

(9) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

Buttons and switches

Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) Volume mute button Mutes and restores speaker sound.

(3) Volume down button Decreases computer volume.

(4) Volume up button Increases computer volume.
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Keys

Component Description

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Front components

Component Description

(1) Webcam light On: The webcam is in use.

(2) External WWAN antenna button Opens the external wireless wide area network (WWAN)
antenna.

(3) External WWAN antenna Sends and receives wireless signals to communicate with
WWANs.

(4) Power switch ● When the computer is off, slide the switch to the right to turn
on the computer.

● When the computer is on, slide the switch to the right to
shut down the computer.

● When the computer is in the Sleep state, slide the switch to
the right briefly to exit Sleep.

● When the computer is in Hibernation, slide the switch to the
right briefly to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, slide the switch to the right and hold
for at least 5 seconds to turn off the computer.

To learn more about your power settings, select Start > Control
Panel > System and Maintenance > Power Options.

(5) Speakers (2) Produce sound.

(6) Business card slot Holds a business card in position so that the webcam can
capture an image.

(7) Display release latch Opens the computer.

(8) Bluetooth® compartment Contains an optional Bluetooth device.
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Right-side components

Component Description

(1) HP Fingerprint Sensor (fingerprint reader) Allows a fingerprint logon to Windows instead of a password
logon.

(2) QuickWeb button ● When the computer is off, press the button to open HP
QuickWeb.

● When the computer is on, press the button to open the
default Web browser.

(3) QuickLook button ● When the computer is off, press the button to open HP
QuickLook.

● When the computer is on, press the button to open Software
Setup.

NOTE: If Software Setup is not available, the default Web
browser opens.

(4) Audio-out (headphone) jack/Audio-in
(microphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.
Also connects an optional headset microphone.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(5) Smart card reader Supports optional smart cards and Java™ Cards.

(6) USB ports (2) Connect optional USB devices.

(7) RJ-11 (modem) jack Connects a modem cable.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.
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Left-side components

Component Description

(1) Media Card Reader Supports the following optional digital card formats:

● Secure Digital (SD) Memory Card

● MultiMediaCard (MMC)

(2) Pen holder Stores the digitizer pen.

(3) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal for the
internal fan to cycle on and off during routine operation.

(4) ExpressCard slot (select models only) Supports optional ExpressCards.

(5) Wireless light ● Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device, the HP Mobile Broadband
Module, and/or a Bluetooth device, is on.

● Amber: All wireless devices are off.

(6) Wireless switch Turns the wireless feature on or off, but does not create a
wireless connection.

NOTE: A wireless network must be set up in order to establish
a wireless connection.

(7) 1394 port Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(8) Powered USB port Provides power to a USB device, such as an optional external
MultiBay, if used with a powered USB cable.
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Rear components

Component Description

(1) Jog dial In tablet mode, functions like the enter key and the up and down
arrows on a standard keyboard.

● Press inward to enter a command.

● Rotate up to scroll up.

● Rotate down to scroll down.

(2) esc button In tablet mode, allows you to exit or escape out of an application.

(3) Rotate button In tablet mode, switches the image between landscape and
portrait orientation.

(4) ctrl+alt+del button In tablet mode:

● While Windows is running, press the button with the pen to
enter the ctrl+alt+del command.*

● While the Computer Setup utility is running, press the button
with the pen to enter the reset command. The computer
resets and all unsaved information is lost. The reset function
can be used to restore functionality when the system has
become unresponsive.

(5) Power connector Connects an AC adapter.

(6) RJ-45 (network) jack Connects a network cable.

(7) External monitor port Connects an external VGA monitor or projector.

*To protect your work and the system, the ctrl+alt+delete command cannot be entered using the ctrl, alt, and del keys on the
on-screen keyboard.
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Bottom components

Component Description

(1) Battery bay Holds the battery and subscriber identity module (SIM).

(2) SIM slot Contains a wireless subscriber identity module (SIM) (select
models only). The SIM slot is located inside the battery bay.

(3) Vents (5) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(4) Hard drive bay Holds the hard drive, memory module slots, WLAN module
(select models only), and WWAN module (select models only).

(5) Docking connector Connects an optional docking device.

(6) Charge level indicator Displays the approximate remaining battery charge.

(7) Battery release latch Releases the battery from the battery bay.

(8) Accessory battery connector Connects an optional accessory battery.

(9) Accessory battery connector door Slides open to expose the accessory battery connector.
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Wireless antennas (select models only)
The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component Description

(1) WWAN antenna (1)* Sends and receives wireless signals to communicate with
wireless wide area networks (WWANs).

(2) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLANs).

(3) External WWAN antenna button** Press to open the external WWAN antenna.

(4) External WWAN antenna** Sends and receives wireless signals to communicate with
WWANs.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

**Before connecting to a WWAN, press the WWAN antenna button to open the external WWAN antenna to a vertical
position. The external WWAN antenna allows you to connect to a WWAN, and then to the Internet, using the integrated HP
Mobile Broadband Module and service from a supported mobile network operator. Do not close the external WWAN antenna
if you are connected to a WWAN.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.
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3 Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

● Model description (5). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.
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Computer major components

Item Description Spare part number

(1) Display assembly (includes 2 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)

 30.7-cm (12.1-in) WXGA, LED, AntiGlare display 597827-001

 30.7-cm (12.1-in) WXGA, LED, AntiGlare display for use outdoors 597828-001

 30.7-cm (12.1-in) WXGA, LED, AntiGlare touch screen display 612497-001

(2) External antenna 597835-001
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Item Description Spare part number

(3) Pointing stick 486565-001

(4) Keyboard with pointing stick (includes two buttons and two cables)

 For use in Belgium 597841-A41

 For use in Brazil 597841-201

 For use in Bulgaria 597841-261

 For use in the Czech Republic 597841-221

 For use in Denmark 597841-081

 For use in France 597841-051

 For use in French Canada 597841-121

 For use in Germany 597841-041

 For use in Greece 597841-DJ1

 For use in Hungary 597841-211

 For use in Iceland 597841-DD1

 For use in Israel 597841-BB1

 For use in Italy 597841-061

 For use in Japan 597841-291

 For use in Latin America 597841-161

 For use in the Netherlands 597841-B31

 For use in Norway 597841-091

 For use in Portugal 597841-131

 For use in Russia 597841-251

 For use in Saudi Arabia 597841-171

 For use in Slovakia 597841-231

 For use in South Korea 597841-AD1

 For use in Spain 597841-071

 For use in Sweden 597841-B71

 For use in Switzerland 597841-BG1

 For use in Taiwan 597841-AB1

 For use in Thailand 597841-281

 For use in Turkey 597841-141

 For use in the United Kingdom 597841-031

 For use in the United States 597841-001

(5) Top cover (includes TouchPad board and capacitive board) 597833-001

(6) Fan/heat sink assembly (includes replacement thermal material) 597840-001
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Item Description Spare part number

(7) System board shield (includes replacement thermal material) 597838-001

(8) RTC battery 482963-001

(9) System board (includes replacement thermal material)  

 For use in all countries and regions except for Russia and the People's Republic of China:  

 ● Equipped with Intel Core i7 620M Dual Core processors (2.66-GHz, 4-MB L3 cache) 607702-001

 ● Equipped with Intel Core i5 540M Dual Core processors (2.53-GHz, 3-MB L3 cache) 600462-001

 ● Equipped with Intel Core i5 520M Dual Core processors (2.40-GHz, 3-MB L3 cache) 600463-001

 For use only in Russia and the People's Republic of China:  

 ● Equipped with Intel Core i7 620M Dual Core processors (2.66-GHz, 4-MB L3 cache) 607706-001

 ● Equipped with Intel Core i5 540M Dual Core processors (2.53-GHz, 3-MB L3 cache) 607704-001

 ● Equipped with Intel Core i5 520M Dual Core processors (2.40-GHz, 3-MB L3 cache) 607705-001

(10) Pen (includes tether) 606899-001

(11) Speaker assembly 597836-001

(12) Audio connector board 597834-001

(13) Bluetooth module (does not include Bluetooth module cable)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 597832-001.
See Cable Kit on page 24 for more Cable Kit spare part number information.

537921-001

(14) Smart card reader 597839-001

(15) Base enclosure 611561-001

(16) Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 597832-001. See
Cable Kit on page 24 for more Cable Kit spare part number information.

 

 For use in all countries and regions except Australia and New Zealand 510099-001

 For use in Australia and New Zealand 510099-011

(17) Latch assembly 597837-001

(18) WWAN module 531993-001

(19) Li-ion battery  

 6-cell, 44-Wh, 2.0-Ah 454668-001

 6-cell, 39-Wh, 2.0-Ah 593592-001

(20) WLAN modules

 Broadcom 4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.
Virgin Islands, and the United States

504593-003
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Item Description Spare part number

 Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands,
Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

 Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

518434-001

 Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia,
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

 Intel Centrino Advanced-N 6200 ABG for use in Pakistan, Russia, and Ukraine 572510-001
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Item Description Spare part number

 Intel Centrino Advanced-N 6200 AGN for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile,
the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico,
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines,
Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands,
Venezuela, and Vietnam

572509-001

(21) Memory modules (PC3-10600, 1333-MHz, DDR3)  

 4-GB 599092-001

 2-GB 598856-001

 1-GB 598859-001

(22) Hard drives (includes Mylar cover with tab, rubber gasket, and bracket)  

 250-GB, 5400-rpm, 4.6-cm (1.8-in) 597825-001

 160-GB, 5400-rpm, 4.6-cm (1.8-in) 607703-001

 160-GB solid-state drive 600464-001

 80-GB solid-state drive 597826-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit 597829-001

(1) Display hinge cover  

(2) ExpressCard slot protective insert

(3) Hard drive cover (includes 4 captive screws, secured by C-clips)

(4) Pick buttons

(5) External antenna  

(6) Smart card reader bezel

(7) Bluetooth module holder  
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Cable Kit

Item Description Spare part number

 Cable Kit 597832-001

(1) Bluetooth module cable

(2) Audio cable

(3) RJ-11 connector cable

Mass storage devices
Description Spare part number

Hard drives (include Mylar cover with tab, rubber gasket, and bracket)

250-GB, 5400-rpm, 4.6-cm (1.8-in) 597825-001

160-GB, 5400-rpm, 4.6-cm (1.8-in) 607703-001

160-GB solid-state drive (SSD) 600464-001

80-GB solid-state drive (SSD) 597826-001
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Miscellaneous parts
Description Spare part number

65-W AC adapter 613152-001

Rubber Kit (includes feet and screw covers) 597830-001

HP 2740 Ultra-Slim Expansion Base 606172-001

External antenna 597835-001

Pointing stick cover 607814-001

Power cords

For use in Argentina 490371-D01

For use in Brazil 490371-201

For use in Denmark 490371-081

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031
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Description Spare part number

For use in the United States 490371-001

Screw Kit

● Phillips PM2.5×12.0 captive screw

● Phillips PM2.0×3.0 screw

● Phillips PM2.0×7.0 captive screw

● Phillips PM3.0×5.0 screw

● Phillips PM2.5×6.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.5×3.0 screw

● Phillips PM2.5×5.0 screw

● Torx T8M2.0×8.0 screw

● Torx T8M2.5×7.0 screw

● Torx T8M2.5×6.0 screw

● Torx T8M2.5×8.0 screw

597831-001

Sequential part number listing
Spare part
number

Description

454668-001 6-cell, 39-Wh, 2.0-Ah, Li-ion battery

482963-001 RTC battery

490371-001 Power cord for use in North America

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel
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Spare part
number

Description

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom 4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-004 Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

510099-001 Modem module for use in all countries and regions except Australia and New Zealand

NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 597832-001. See Cable Kit on page 24 for more Cable
Kit spare part number information.

510099-011 Modem module for use in Australia and New Zealand

518434-001 Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States
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Spare part
number

Description

518434-002 Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

531993-001 WWAN Module

537921-001 Bluetooth module (does not include cable)

572509-001 Intel Centrino Advanced-N 6200 AGN WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia and
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of China,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi
Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab Emirates,
the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

572510-001 Intel Centrino Advanced-N 6200 ABG WLAN module for use in Pakistan, Russia, and Ukraine

593592-001 6-cell, 44-Wh, 2.0-Ah, Li-ion battery

597825-001 250-GB, 5400-rpm, 4.6-cm (1.8-in) hard drive (includes Mylar cover with tab, rubber gasket, and bracket)

597826-001 80-GB solid-state drive (includes Mylar cover with tab, rubber gasket, and bracket)

597827-001 30.7-cm (12.1-in) WXGA, LED, AntiGlare display assembly (includes 2 WLAN antenna transceivers and
cables and 2 WWAN antenna transceivers and cables)

597828-001 30.7-cm (12.1-in) WXGA, LED, AntiGlare display for use outdoors (includes 2 WLAN antenna transceivers
and 2 WWAN antenna transceivers and cables)

597829-001 Plastics Kit (see Plastics Kit on page 23 for more Plastics Kit spare part information)

597830-001 Rubber Kit (includes feet and screw covers)

597831-001 Screw Kit 

597832-001 Cable Kit (see Cable Kit on page 24 for more Cable Kit spare part information)

597833-001 Top cover (includes TouchPad board and capacitive board)
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Spare part
number

Description

597834-001 Audio connector board

597835-001 External antenna

597836-001 Speaker assembly 

597837-001 Latch assembly (includes latch, bracket, two screws, and spring)

597838-001 System board shield (includes replacement thermal material)

597839-001 Smart card reader

597840-001 Fan/heat sink assembly (includes replacement thermal material)

597841-001 Keyboard with pointing stick for use in the United States (includes two buttons and two cables)

597841-031 Keyboard with pointing stick for use in the United Kingdom (includes two buttons and two cables)

597841-041 Keyboard with pointing stick for use in Germany (includes two buttons and two cables)

597841-051 Keyboard with pointing stick for use in France (includes two buttons and two cables)

597841-061 Keyboard with pointing stick for use in Italy (includes two buttons and two cables)

597841-071 Keyboard with pointing stick for use in Spain (includes two buttons and two cables)

597841-081 Keyboard with pointing stick for use in Denmark (includes two buttons and two cables)

597841-091 Keyboard with pointing stick for use in Norway (includes two buttons and two cables)

597841-121 Keyboard with pointing stick for use in French Canada (includes two buttons and two cables)

597841-131 Keyboard with pointing stick for use in Portugal (includes two buttons and two cables)

597841-141 Keyboard with pointing stick for use in Turkey (includes two buttons and two cables)

597841-161 Keyboard with pointing stick for use in Latin America (includes two buttons and two cables)

597841-171 Keyboard with pointing stick for use in Saudi Arabia (includes two buttons and two cables)

597841-201 Keyboard with pointing stick for use in Brazil (includes two buttons and two cables)

597841-211 Keyboard with pointing stick for use in Hungary (includes two buttons and two cables)

597841-221 Keyboard with pointing stick for use in the Czech Republic (includes two buttons and two cables)

597841-231 Keyboard with pointing stick for use in Slovakia (includes two buttons and two cables)

597841-251 Keyboard with pointing stick for use in Russia (includes two buttons and two cables)

597841-261 Keyboard with pointing stick for use in Bulgaria (includes two buttons and two cables)

597841-281 Keyboard with pointing stick for use in Thailand (includes two buttons and two cables)

597841-291 Keyboard with pointing stick for use in Japan (includes two buttons and two cables)

597841-A41 Keyboard with pointing stick for use in Belgium (includes two buttons and two cables)

597841-AB1 Keyboard with pointing stick for use in Taiwan (includes two buttons and two cables)

597841-AD1 Keyboard with pointing stick for use in South Korea (includes two buttons and two cables)

597841-B31 Keyboard with pointing stick for use in the Netherlands and Europe (includes two buttons and two cables)

597841-B71 Keyboard with pointing stick for use in Sweden (includes two buttons and two cables)
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Spare part
number

Description

597841-BB1 Keyboard with pointing stick for use in Israel (includes two buttons and two cables)

597841-BG1 Keyboard with pointing stick for use in Switzerland (includes two buttons and two cables)

597841-DD1 Keyboard with pointing stick for use in Iceland (includes two buttons and two cables)

597841-DJ1 Keyboard with pointing stick for use in Greece (includes two buttons and two cables)

598856-001 2-GB memory module (PC3-10600, 1333-MHz, DDR3)

598859-001 1-GB memory module (PC3-10600, 1333-MHz, DDR3)

599092-001 4-GB memory module (PC3-10600, 1333-MHz, DDR3)

600462-001 System board with Intel Core i5 540M Dual Core processor (2.53-GHz, 3-MB L3 cache) for use in all
countries and regions except for Russia and the People's Republic of China

600463-001 System board with Intel Core i5 520M Dual Core processor (2.40-GHz, 3-MB L3 cache) for use in all
countries and regions except for Russia and the People's Republic of China

600464-001 160-GB solid-state drive (includes Mylar cover with tab, rubber gasket, and bracket)

606172-001 HP 2740 Ultra-Slim Expansion Base

606899-001 Pen (includes tether)

607702-001 System board with Intel Core i7 620M Dual Core processor (2.66-GHz, 4-MB L3 cache) for use in all
countries and regions except for Russia and the People's Republic of China

607703-001 160-GB, 5400-rpm, 4.6-cm (1.8-in) hard drive (includes Mylar cover with tab, rubber gasket, and bracket)

607704-001 System board with Intel Core i5 540M Dual Core processor (2.53-GHz, 3-MB L3 cache) for use only in
Russia and the People's Republic of China

607705-001 System board with Intel Core i5 520M Dual Core processor (2.40-GHz, 3-MB L3 cache) for use only in
Russia and the People's Republic of China

607706-001 System board with Intel Core i7 620M Dual Core processor (2.66-GHz, 4-MB L3 cache) for use only in
Russia and the People's Republic of China

607814-001 Pointing stick cover

611561-001 Base enclosure

612497-001 30.7-cm (12.1-in) WXGA, LED, AntiGlare touch screen display (includes 2 WLAN antenna transceivers and
2 WWAN antenna transceivers and cables)

613152-001 65-W AC adapter
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4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.

34 Chapter 4   Removal and replacement procedures ENWW



Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

● Product name (1). This is the product name affixed to the front of the computer.

● Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

● Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

● Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

● Model description (5). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 595785-001. There are four rubber feet that attach to the base enclosure in the locations
illustrated below.
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Pen

Description Spare part number

Pen (includes tether) 606899-001

Remove the pen:

1. Position the computer right-side up, with the left side toward you.

2. Pull the loop on the tether until it is large enough to pass the pen through it, and then pull the
pen through the loop (1).

3. Remove the pen and tether from the computer (2).

Reverse this procedure to install the pen.
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Battery

Description Spare part number

8-cell, 44-Wh, 2.0-Ah, Li-ion battery 454668-001

8-cell, 39-Wh, 2.0-Ah, Li-ion battery 593592-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the edge of the battery upward (2) and remove it from the computer (3).

To insert the battery, insert the front edge of the battery into the battery bay and pivot the rear edge of
the battery downward until it is seated. The battery release latch automatically locks the battery into
place.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Hard drive
NOTE: All hard drive spare part kits include Mylar cover with tab, rubber gasket, and bracket.

Description Spare part number

250-GB, 5400-rpm, 4.6-cm (1.8-in) hard drive 597825-001

160-GB, 5400-rpm, 4.6-cm (1.8-in) hard drive 607703-001

160-GB solid-state drive (SSD) 600464-001

80-GB solid-state drive (SSD) 597826-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

Remove the hard drive:

1. Position the computer upside-down, with the front toward you.

2. Loosen the three Phillips PM2.0×5.0 captive screws (1) that secure the hard drive cover to the
computer.

3. Lift the rear edge of the hard drive cover (2) until it rests at an angle, and then remove the hard
drive cover. The hard drive cover is included in the Plastics Kit, spare part number 597829-001.

4. Remove the two Phillips PM2.0×3.0 screws (1) that secure the hard drive bracket to the
computer.
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5. Lift the left side of the bracket up at an angle (2), and then remove the bracket from the
computer (3).

NOTE: The right side of the bracket has a tab that fits into a slot in the computer. When
reinstalling, make sure to insert the tab into the slot or the bracket will not seat correctly.

6. At the corner of the hard drive, pull the drive up (1) until it rests at an angle.

7. Pull the hard drive away from the bay and out of the computer (2).

Reverse this procedure to reassemble and install the hard drive.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Broadcom BCM4312 802.11/b/g WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

504593-003

Broadcom BCM4312 802.11/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia,
Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South
Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

504593-004

Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the
U.S. Virgin Islands, and the United States

518434-001

Broadcom 4322 AGN 802.11a/b/g/draft-n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

518434-002
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Description Spare part number

Intel Centrino Advanced-N 6200 AGN for use in Andorra, Antigua and Barbuda, Argentina, Aruba,
Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia
and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic
of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic,
Ecuador, Egypt, El Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany,
Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait,
Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania, Luxembourg, Malawi,
Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay,
Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia,
Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab
Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela,
and Vietnam

572509-001

Intel Centrino Advanced-N 6200 ABG for use in Pakistan, Russia, and Ukraine 572510-001

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×3.0 barrel screws (2) that secure the WLAN module to the
computer. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.

ENWW Component replacement procedures 45



WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

WWAN module 531993-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Memory modules

Description Spare part number

1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001

2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001

4-GB (PC3-10600, 1333-MHz, DDR3) 599092-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Keyboard

For use in: Spare part number For use in: Spare part number

Keyboard with pointing stick (includes two buttons and two cables):

Belgium

Brazil

Bulgaria

Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

South Korea

597841-A41

597841-201

597841-261

597841-221

597841-081

597841-051

597841-121

597841-041

597841-DJ1

597841-211

597841-DD1

597841-BB1

597841-061

597841-291

597841-AD1

Latin America

The Netherlands and Europe

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

597841-161

597841-B31

597841-091

597841-131

597841-251

597841-171

597841-231

597841-071

597841-B71

597841-BG1

597841-AB1

597841-281

597841-141

597841-031

597841-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41).

Remove the keyboard:

1. Turn the computer upside-down, with the front toward you.
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2. Remove the two Mylar screw covers (1) and the six Torx T8M2.0×8.0 screws (2) that secure the
keyboard to the computer.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the upper rear edge of the keyboard (1) until it releases, work your way across the top of the
keyboard toward the right while releasing the keyboard from the top cover, lift the rear of the
keyboard up until it rests at an angle (2), and then lift the keyboard up enough to gain access to
the cables underneath (3).

6. Release the zero insertion force (ZIF) connector to which the keyboard cable is attached (1), and
then disconnect the keyboard cable from the system board.
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7. Release the ZIF connector to which the pointing stick cable (2) is attached, and then disconnect
the pointing stick cable from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Top cover
All top covers include TouchPad board and capacitive board.

Description Spare part number

Top cover 597833-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the keyboard (see Keyboard on page 48)

6. Remove the hard drive cover (see Hard drive on page 41).

Remove the top cover:

1. Turn the computer upside-down, with the front toward you.

2. Remove the two Torx T8M2.0×8.0 screws (1) located in the bottom feet. You do not need to
remove the feet.

3. Remove the two Torx T8M2.0×6.0 screws (2) located below the battery bay.

4. Turn the computer right-side up, with the front toward you.

5. Open the computer as far as possible.

6. Remove the two Phillips PM2.5×7.0 screws (1) from the top of the top cover.

7. Disconnect the TouchPad cable from the system board ZIF connector (2).
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8. Disconnect the capacitive strip cable from the system board ZIP connector (3).

9. Lift the edge of the top cover near the TouchPad (1) to disengage it from the computer.

10. Disengage the remainder of the top cover from the computer, and then lift the top cover up (2)
and off the computer.

Reverse this procedure to install the top cover.
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RTC battery

Description Spare part number

RTC battery 482963-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive cover (see Hard drive on page 41).

b. Keyboard (see Keyboard on page 48).

c. Top cover (see Top cover on page 51).

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Gently pull the battery away from the double-sided tape that secures it to the system board (2)
and remove it from the computer.

Reverse this procedure to install the RTC battery.
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Audio connector board

Description Spare part number

Audio connector board 597834-001

Before removing the audio connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive cover (see Hard drive on page 41).

b. Keyboard (see Keyboard on page 48)

c. Top cover (see Top cover on page 51)

Remove the audio connector board:

1. Position the computer right-side up, with the front toward you.

2. Disconnect the speaker cable (1) from the audio connector board.

3. Disconnect the audio cable (2) from the audio connector board ZIF connector.

4. Remove the two Phillips PM2.0×4.0 screws (1) that secure the audio connector board to the
base enclosure.
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5. Lift the board (2) up at an angle, then slide the board toward the front of the computer (3) until it
is clear of the system board shield.

Reverse this procedure to install the audio connector board.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 597832-001. See Cable Kit
on page 24 for more Cable Kit spare part number information.

The Bluetooth module holder is included in the Plastics Kit, spare part number 597829-001. See
Plastics Kit on page 23 for more Plastics Kit spare part number information.

Description Spare part number

Bluetooth module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 48)

c. Top cover (see Top cover on page 51)

Remove the Bluetooth module:

1. Position the computer right-side up, with the front toward you.

2. Remove the foam insulator from in front of the module (1).

3. Remove the Phillips PM2.0×4.0 screw (2) that secures the Bluetooth module holder to the
computer.
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4. Lift the Bluetooth module holder (3) as far as the cable will allow.

5. Slide the Bluetooth module from the holder (1), and then disconnect the Bluetooth module cable
from the Bluetooth module (2).

6. Remove the Bluetooth module and holder from the computer.

Reverse this procedure to reassemble and install the Bluetooth module and holder.
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Latch assembly
NOTE: All latch assembly kits include the latch, bracket, two screws, and spring.

Description Spare part number

Latch assembly 597837-001

Before removing the latch assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 48)

c. Top cover (see Top cover on page 51)

NOTE: The latch mechanism includes a small spring. Please note the installed location of this
spring in the following illustration prior to disassembling the latch mechanism to allow for correct
reassembly.

Remove the latch assembly:

1. Position the computer right-side up, with the front toward you.

2. Remove the two Phillips PM2.0×4.0 screws (1) that secure the latch bracket to the base
enclosure.
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3. Detach the spring from the latch (2).

4. Lift the bracket from the computer (1), pull the front latch away from the front of the computer (2),
and then lift the inner latch piece from the computer (3).

Reverse this procedure to install the latch assembly.
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Speaker assembly

Description Spare part number

Speaker assembly 597836-001

Before removing the speaker assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 48)

c. Top cover (see Top cover on page 51)

NOTE: Removal of the speakers involves loosening the front latch mechanism. This mechanism
includes a small spring. Please note the installed location of this spring in the following illustration
prior to disassembling the latch mechanism to allow for correct reassembly.

Remove the speaker assembly:

1. Position the computer right-side up, with the front toward you.
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2. Unplug the speaker cable (1) from the audio connector board, and note the routing channel (2)
of the speaker cable on the enclosure base.

3. Remove the two Phillips PM2.0×4.0 screws (1) that secure the speaker assembly to the base
enclosure.

4. Slide the speakers toward the right (2), and then lift the speakers and cables from the base
enclosure (3).

Reverse this procedure to install the speaker assembly.
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Display assembly
All display assemblies include two WLAN antenna transceivers and cables and two WWAN antenna
transceivers and cables.

Description Spare part number

30.7-cm (12.1-in) WXGA, LED, AntiGlare display assembly 597827-001

30.7-cm (12.1-in) WXGA, LED, AntiGlare display for use outdoors 597828-001

30.7-cm (12.1-in) WXGA, LED, AntiGlare, touch screen display 612497-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41).

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 43) and the WWAN module (see WWAN module on page 46).

7. Remove the following components:

a. Keyboard (see Keyboard on page 48)

b. Top cover (see Top cover on page 51)

Remove the display assembly:

1. Position the computer upside down, with the rear toward you.

2. Remove the two Torx TM2.0×5.0 screws that secure the hinge cover to the computer.

62 Chapter 4   Removal and replacement procedures ENWW



3. Position the computer right-side up, with the rear toward you.

4. Slide the hinge cover away from the computer. The hinge cover is available in the Plastics Kit,
spare part number 597829-001.

5. Position the computer right-side up, with the front toward you.

6. Disconnect the display panel cable (1) from the system board.

7. Remove the display panel cable from the clip built into the system board shield (2).

8. Disconnect the microphone cable (3) from the system board.

9. Remove the WLAN and WWAN antenna cables from the channel, clips, and tape that secure the
cables to the system board shield (4).

10. Position the computer right-side up, with the rear toward you.

11. Rotate the display (1) to gain easier access to the screws in the display bracket.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.
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12. Remove two Phillips PM2.5×7.0 screws (2) that secure the display assembly to the base
enclosure.

13. Rotate the display (1) to gain access to the remaining two screws in the display bracket.

14. Remove remaining two Phillips PM2.5×7.0 screws (2) that secure the display assembly to the
base enclosure.

64 Chapter 4   Removal and replacement procedures ENWW



15. Lift the display assembly straight up and remove it.

CAUTION: When installing the display assembly, be sure that the four wireless antenna cables
are routed and arranged properly.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.

Reverse this procedure to reassemble and install the display assembly.
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System board shield
NOTE: All system board shield kits include replacement thermal material.

Description Spare part number

System board shield 597838-001

Before removing the system board shield, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41)

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 43) and the WWAN module (see WWAN module on page 46).

7. Remove the following components:

a. Keyboard (see Keyboard on page 48)

b. Top cover (see Top cover on page 51)

c. Display assembly (see Display assembly on page 62)

Remove the system board shield:

1. Position the computer right-side up, with the front toward you.

2. Remove the two PM2.0×4.0 screws (1) and two the PM2.0×3.0 screws (2) that secure the shield
to the computer.
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3. Remove the shield from the computer (3).

Reverse this procedure to install the system board shield.

Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 597832-001. See Cable Kit on page 24
for more Cable Kit spare part number information.

Description Spare part number

Modem module for use in all countries and regions except Australia and New Zealand 510099-001

Modem module for use in Australia and New Zealand 510099-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41)

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 43) and the WWAN module (see WWAN module on page 46).

7. Remove the following components:

a. Keyboard (see Keyboard on page 48)

b. Top cover (see Top cover on page 51)
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c. Display assembly (see Display assembly on page 62)

d. System board shield (see System board shield on page 66)

Remove the modem module:

1. Turn the computer right-side up, with the front toward you.

2. Disconnect the modem module (1) from the system board by lifting it straight up.

3. Disconnect the modem module cable (2) from the modem module, and then remove the module
from the computer.

Reverse this procedure to install the modem module.

Smart card reader

Description Spare part number

Smart card reader (includes cable) 597839-001

Before removing the smart card reader, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive cover (see Hard drive on page 41)
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6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 43) and the WWAN module (see WWAN module on page 46).

7. Remove the following components:

a. Keyboard (see Keyboard on page 48)

b. Top cover (see Top cover on page 51)

c. Display assembly (see Display assembly on page 62)

d. System board shield (see System board shield on page 66)

Remove the smart card reader:

1. Position the computer right-side up, with the front toward you.

2. Disconnect the smart card reader cable from the ZIF connector on the system board (1).

3. Lift the smart card reader out of the chassis (2)

NOTE: Adhesive secures the reader to the base enclosure. You must break the adhesion to
remove the reader.

Reverse this procedure to install the smart card reader.
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System board
NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

For use in all countries and regions except for Russia and the People's Republic of China:  

● Equipped with Intel Core i7 620M Dual Core processors (2.66-GHz, 4-MB L3 cache) 607702-001

● Equipped with Intel Core i5 540M Dual Core processors (2.53-GHz, 3-MB L3 cache) 600462-001

● Equipped with Intel Core i5 520M Dual Core processors (2.40-GHz, 3-MB L3 cache) 600463-001

For use only in Russia and the People's Republic of China:  

● Equipped with Intel Core i7 620M Dual Core processors (2.66-GHz, 4-MB L3 cache) 607706-001

● Equipped with Intel Core i5 540M Dual Core processors (2.53-GHz, 3-MB L3 cache) 607704-001

● Equipped with Intel Core i5 520M Dual Core processors (2.40-GHz, 3-MB L3 cache) 607705-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 48)

c. Top cover (see Top cover on page 51)

d. Display assembly (see Display assembly on page 62)

e. System board shield (see System board shield on page 66)

f. Smart card reader (see Smart card reader on page 68)

g. Modem module (see Modem module on page 67)

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

● SIM (see SIM on page 40)

● Memory modules (see Memory modules on page 47)

● WLAN module (see WLAN module on page 43)

● WWAN module (see WWAN module on page 46)
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● Modem module (see Modem module on page 67)

● Heat sink (see Fan/heat sink assembly on page 73)

Remove the system board:

1. Position the computer right-side up, with the front toward you.

2. Remove the ExpressCard or ExpressCard slot holder.

3. Disconnect the audio connector board cable (1) and the Bluetooth module cable (2) from the
system board.
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4. Remove the Phillips PM2.0×4.0 screw that secures the system board to the base enclosure.

5. Lift the right side of the system board (1), and then lift it out of the base enclosure (2).

Reverse this procedure to install the system board.
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Fan/heat sink assembly
All heat sink spare part kits include replacement thermal material.

Description Spare part number

Fan/heat sink assembly 597840-001

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. WLAN module (see WLAN module on page 43)

b. WWAN module (see WWAN module on page 46)

c. Hard drive (see Hard drive on page 41)

d. Keyboard (see Keyboard on page 48)

e. Top cover (see Top cover on page 51)

f. Display assembly (see Display assembly on page 62)

g. System board shield (see System board shield on page 66)

h. Modem module (see Modem module on page 67)

i. System board (see System board on page 70)

j. Smart card reader (see Smart card reader on page 68)

Remove the fan/heat sink assembly:

1. Position the system board upside down.

ENWW Component replacement procedures 73



2. Disconnect the fan cable from the system board.

3. In the order indicated on the heat sink, loosen the four Phillips captive screws (1) that secure the
heat sink to the base enclosure.

4. Remove the fan/heat sink assembly from the system board (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
processor (2) each time the heat sink is removed. Thermal material is included with all heat sink and
processor spare part kits.
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Reverse this procedure to install the fan/heat sink assembly.

Misc cables
NOTE: The Cable Kit includes the audio connector board cable, Bluetooth cable, and RJ-11
connector and cable.

Description Spare part number

Cable Kit 597832-001

Before removing the cables, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 48)

c. Display assembly (see Display assembly on page 62)

d. Top cover (see Top cover on page 51)

e. System board shield (see System board shield on page 66)

f. Modem module (see Modem module on page 67)
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g. System board (see System board on page 70)

h. Smart card reader (see Smart card reader on page 68)

Remove the cables:

1. Position the computer right-side up, with the right side toward you.

2. Remove the necessary cable as follows, noting the routing path of the cable:

● (1) Audio connector board cable

● (2) Bluetooth cable

● (3) RJ-11 connector and cable

Reverse this procedure to install the cables.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys, and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow on the right side of the screen,
or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, or System Configuration menu.
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To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System Information ● View identification information for the computer and the
batteries in the system.

● View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

● System Information

◦ Identification information for the computer and the
batteries in the system.

◦ Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

● Start-up Test—Verifies the system components needed
for starting the computer.

● Run-In Test—Runs a comprehensive check on system
memory.

● Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

● Memory Test—Runs a comprehensive test on any
memory installed in the computer.

● Battery Test—Runs a comprehensive test on any
batteries installed in the computer.

● Error Log—Displays a log file if any errors have
occurred.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.

Ignore Changes and Exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes and Exit Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management > Create New BIOS User Account
(requires a BIOS administrator password) 

● Select from a list of BIOS users.

● Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft > AT-p Enable/disable Anti-Theft Protection.

DriveLock Password ● Enable/disable DriveLock on any computer hard drive
(enabled by default).

● Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.

NOTE: You must have a setup password to change this
setting.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.

Boot Options ● Set a startup menu delay (in seconds).

● Set the MultiBoot Express popup delay (in seconds).

● Enable/disable custom logo (disabled by default).

● Enable/disable display diagnostic URL (enabled by
default).

● Enable/disable CD-ROM boot (enabled by default).

● Enable/disable SD card boot (enabled by default).

● Enable/disable floppy boot (enabled by default).

● Enable/disable PXE internal NIC boot (enabled by
default).

● Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

● Set the legacy boot order.

Device Configurations ● Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

◦ Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running

◦ Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer

● Enable/disable fan always on while connected to an AC
outlet (disabled by default).

● Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

● Select a SATA (Serial Advanced Technology
Attachment) device mode. The following options are
available:

◦ AHCI (Advanced Host Controller Interface)

◦ IDE (Integrated Drive Electronics)

◦ RAID (Redundant Array of Independent Disks)
(select models only)
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Select To do this

NOTE: Availability of these options varies by computer
model.

● Enable/disable secondary battery fast charge (enabled
by default).

● Enable/disable HP QuickLook (enabled by default).

● Enable/disable preboot authentication on HP QuickLook
boot (enabled by default).

● Enable/disable HP QuickWeb (enabled by default).

● Enable/disable HP QuickWeb write protect (disabled by
default).

● Enable/disable virtualization technology (select models
only; disabled by default).

● Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

● Enable/disable Multi Core CPU (enabled by default).

● Enable/disable Intel HT Technology (enabled by
default).

● Enable/disable Wake on USB (enabled by default).

● Enable/disable Num lock state at boot (disabled by
default).
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Select To do this

Built-In Device Options ● Enable/disable the wireless button state (enabled by
default).

● Enable/disable embedded WWAN device radio (select
models only; enabled by default).

● Enable/disable embedded WLAN device radio (select
models only; enabled by default).

● Enable/disable the embedded Bluetooth device radio
(enabled by default).

● Enable/disable the network interface controller (enabled
by default).

● Enable/disable LAN/WLAN switching (disabled by
default).

● Set the wake on LAN state. Options include the
following:

◦ Disabled

◦ Boot to Network

◦ Follow Boot Order

● Enable/disable the ambient light sensor.

● Enable/disable the fingerprint device (enabled by
default).

● Enable/disable the integrated camera (enabled by
default).

● Enable/disable the power monitor circuit (enabled by
default).

● Enable/disable the audio device (enabled by default).

● Enable/disable a modem device (enabled by default).

● Enable/disable the microphone (enabled by default).

● Enable/disable the internal speakers (enabled by
default).

Port Options NOTE: All port options are enabled by default.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the ExpressCard slot.

● Enable/disable the Smart card slot.

● Enable/disable the eSATA port.
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Select To do this

AMT Options NOTE: All AMT options are disabled by default.

● Enable/disable firmware verbosity.

● Enable/disable AMT setup prompt (Ctrl-P).

● Enable/disable USB key provisioning support.

● Enable/disable unconfigure AMT on next boot.

● Select terminal emulation mode:

◦ ANSI

◦ VT100

● Enable/disable firmware progress event support.

● Enable/disable initiate Intel CIRA.

Set Security Level Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults Restore the default security settings.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Length 21.2 cm 8.35 in

Width 29.0 cm 11.4 in

Height (front to rear) 3.2 cm 1.25 in

Weight (equipped with 1 DIMM, 6-cell battery, WLAN
module)

1.72 kg 3.80 lbs

Input power

Operating voltage 18.5 V dc @ 3.5 A – 65 W

Operating current 3.5 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m 50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

30.7-cm (12.1-in), WXGA display specifications
 Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Surface treatment Anti-glare

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40° horizontal

+120°/-40° horizontal
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Hard drive specifications
 160-GB* 250-GB*

Dimensions

Height 8.0 mm 8.0 mm

Width 45.7 mm 45.7 mm

Weight 101 g 101 g

Interface type SATA SATA

Transfer rate 100 MB/sec 100 MB/sec

Security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms

Average 13 ms 13 ms

Maximum 24 ms 24 ms

Logical blocks 312,581,808 488,397,168

Disc rotational speed 5400 rpm 5400 rpm

Operating temperature  

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only)

● Backing up individual files and folders

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.
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● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.
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NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities, from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition.

To check for the Windows partition, select Start > Computer.

To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.

NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4. On the Advanced Boot Options screen, use the arrow keys to highlight Repair your computer,
and then press enter.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
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To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 to enter the HP Recovery menu.

5. Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows 7 operating system
DVD, go to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

● Backing up individual files and folders

● Backing up the entire hard drive (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents folder, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.
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● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities, from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and then
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follow the on-screen instructions. You can also order the DVD by calling technical support. For
contact information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

Windows XP
To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore
your computer.

Windows provides the following options:

● Backing up individual files and folders

● Backing up all files and folders

● Scheduling automatic backups

● Creating recovery points

● Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
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Note the following when backing up:

● Store personal files in the My Documents folder, and back it up periodically.

● Back up templates stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

● Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.
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NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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8 Connector pin assignments

1394

Pin Signal

1 Power

2 Ground

3 TPB-

4 TPB+

5 TPA-

6 TPA+

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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Index

Symbols/Numerics
1394 port

identifying 12
pin assignments 99

A
AC adapter, spare part

numbers 30
accessory battery connector,

identifying 14
ambient light sensor

identifying 5
AMT options

AMT setup prompt (Ctrl-P) 84
firmware progress event

support 84
firmware verbosity 84
initiate Intel CIRA 84
terminal emulation mode 84
unconfigure AMT on next

boot 84
USB key provisioning

support 84
antennas

disconnecting 44, 46
external WWAN 15
WLAN 15
WWAN 15

Anti Theft 80
applications key, Windows 9
audio cable, illustrated 24
audio connector board

removal 54
spare part number 20, 29, 54

audio, product description 2
audio-in (microphone) jack

identifying 11
pin assignments 99

audio-out (headphone) jack
identifying 11
pin assignments 100

B
backing up files 89
Backup and Restore 89, 90
Backup and Restore

Center 93, 94
base enclosure, spare part

number 20, 30
battery

removal 39
spare part

number 20, 26, 28, 39
battery bay 14
battery light 7
battery release latch,

identifying 14
bays

battery 14
hard drive 14

BIOS administrator password 80
Bluetooth cable, illustrated 24
Bluetooth compartment,

identifying 10
Bluetooth module

removal 56
spare part number 20, 28, 56

Bluetooth module cover,
illustrated 23

boot options 81
boot order 81
built-in device

Ambient Light Sensor 83
audio devices 83
Bluetooth device radio 83
fingerprint reader 83
integrated camera 83
internal speakers 83

LAN/WLAN switching 83
microphone 83
modem 83
Network Interface Controller

(LAN) 83
Power Monitor Circuit 83
Wake on LAN 83
wireless button 83
WLAN device radio 83
WWAN device radio 83

built-in device options 83
business card slot 10
buttons

ctrl+alt+del 13
esc 13
external WWAN

antenna 10, 15
keyboard light 5
pointing stick 6
QuickLook 11
QuickWeb 11
rotate 13
TouchPad 6
volume down 8
volume mute 8
volume up 8

C
Cable Kit

contents 24
spare part number 24, 28

cables
removal 75
service considerations 32

caps lock light, identifying 7
charge level indicator,

identifying 14
chipset, product description 1
components

bottom 14
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display 5
front 10
left-side 12
rear 13
right-side 11
top 6

computer feet
locations 37
spare part number 37

Computer Setup
File menu 79
navigating and selecting 77
restoring factory settings 78
Security menu 80
System Configuration

menu 81
computer specifications 85
connector, power 13
connectors, service

considerations 32
convertible hinge, identifying 5
creating a backup 89
ctrl+alt+del button 13

D
device configurations 81
discs

Driver Recovery 97
Operating System 97, 98

disk sanitizer 80
display assembly

removal 62
spare part numbers 18, 28, 62

display hinge cover, illustrated 23
display panel

product description 1
display release latch,

identifying 10
display specifications 86
display switch, identifying 8
docking connector, identifying 14
docking station, spare part

number 25, 30
docking support, product

description 3
drive light ,identifying 7
DriveLock password 80
DriveLock, automatic 80
Driver Recovery disc 97
drives, boot order 81

drives, preventing damage 32

E
electrostatic discharge 33
esc button 13
esc key, identifying 9
Ethernet, product description 2
Execution Disable 81
ExpressCard slot 12
ExpressCard slot insert,

illustrated 23
external antenna

illustrated 23
spare part number 25, 29

external media cards, product
description 2

external monitor port
identifying 13
pin assignments 100

external WWAN antenna button,
identifying 10

F
f11 recovery 91, 95
fan/heat sink assembly

removal 71
spare part number 19, 71

feet
locations 37
spare part number 37

File menu 79
fingerprint reader,

identifying 5, 11
fn key

identifying 9
using 6

function keys, identifying 9

G
graphics, product description 1
grounding equipment and

methods 35

H
hard drive

precautions 32
product description 1
removal 41
spare part number 28

spare part
numbers 22, 24, 30, 41

specifications 87
hard drive bay, identifying 14
hard drive bracket, removal 42
hard drive cover

illustrated 23
removal 41

hard drive recovery 91, 95
headphone (audio-out) jack

pin assignments 99
heat sink, spare part number 29
hinge, convertible 5
HP QuickLook 82
HP SpareKey enrollment 80

I
IEEE 1394 port, identifying 12
Intel HT Technology 82
internal display switch,

identifying 8
internal microphone, identifying 5

J
jacks

audio-in (microphone) 11
audio-out (headphone) 11
RJ-11 (modem) 11
RJ-45 (network 13

jog dial 13

K
keyboard

product description 3
removal 48
spare part numbers 19, 29, 48

keyboard light button,
identifying 5

keypad keys, identifying 9
keys

esc 9
fn 9
function 9
keypad 9
Windows applications 9
Windows logo 9

L
language, changing in Computer

Setup 81
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latch assembly
removal 58
spare part number 20, 29, 58

latch, battery release 14
legacy support, USB 77, 81
lights

battery 7
caps lock 7
drive 7
mute 7
num lock 8
power 7
TouchPad 6, 7
volume down 7
volume mute 7
volume up 8
webcam 5, 10
wireless 12

M
mass storage devices, spare part

numbers 24
Media Card Reader,

identifying 12
memory module

product description 1
removal 47
spare part numbers 22, 47

microphone (audio-in) jack
pin assignments 100

microphone, internal 5
microphone, product

description 2
model name 1
modem jack, pin

assignments 101
modem module

product description 2
removal 67
spare part number 20, 27, 67

monitor port
external 13
pin assignments 100

Multi Core CPU 82
mute button, identifying 8
mute light, identifying 7

N
network jack, pin

assignments 101

num lock light, identifying 8

O
Operating System disc 97, 98
operating system, product

description 3

P
packing guidelines 34
passwords 80
pen

removal 38
spare part number 20, 30, 38

pen holder, identifying 12
pick button, illustrated 23
pin assignments

1394 99
audio-in jack 100
audio-out jack 99
external monitor port 100
headphone jack 99
microphone jack 100
modem jack 101
monitor port 100
network jack 101
RJ-11 101
RJ-45 jack 101
Universal Serial Bus (USB)

port 102
plastic parts 31
Plastics Kit

contents 23
spare part number 23, 28

pointing device, product
description 3

pointing stick buttons,
identifying 6

pointing stick cover, spare part
number 25, 30

pointing stick, identifying 6
port options

1394 port 83
eSATA port 83
ExpressCard slot 83
flash media reader 83
Smart card slot 83
USB port 83

ports
1394 12
external monitor 13

product description 2
USB 11

power connector, identifying 13
power cord

set requirements 103
spare part numbers 25, 26

power light, identifying 7
power requirements, product

description 3
power switch, identifying 10
processor, product description 1
product description

audio 2
chipset 1
display panel 1
docking support 3
Ethernet 2
external media cards 2
graphics 1
hard drives 1
keyboard 3
memory module 1
microphone 2
modem module 2
operating system 3
pointing devices 3
ports 2
power requirements 3
processors 1
product name 1
security 3
webcam 2
wireless 2

product name 1

Q
QuickLook button, identifying 11
QuickWeb button, identifying 11

R
reader, fingerprint 5, 11
recovery partition 91, 95
release latch, battery 14
removal/replacement

preliminaries 31
procedures 36

restore security defaults 84
restore the factory settings 79
restoring the hard drive 91, 95
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RJ-11 (modem) jack
identifying 11
pin assignments 101

RJ-11 connector cable
illustrated 24

RJ-45 (network) jack
identifying 13
pin assignments 101

rotate button 13
RTC battery

removal 53
spare part number 20, 26, 53

Rubber Kit, spare part
number 25, 28

S
SATA (Serial Advanced

Technology Attachment) devices
AHCI (Advanced Host

Controller Interface) 81
IDE (Integrated Drive

Electronics) 81
Screw Kit, spare part

number 26, 28
scroll zone, TouchPad 6
Secondary Battery Fast

Charge 82
security cable slot, identifying 11
Security menu

always prompt for HP
SpareKey enrollment 80

Automatic DriveLock 80
change password 80
Disk Sanitizer 80
DriveLock 80
fingerprint reader reset 80
HP Sparekey 80
HP Sparekey enrollment 80
password policy 80
set up BIOS administrator

password 80
System IDs 80

security, product description 3
service considerations 31
service tag 17, 36
set security level 84
setup utility

File menu 79
navigating and selecting 77
restoring factory settings 78

Security menu 80
System Configuration

menu 81
SIM slot, identified 14
SIM, removal 40
slots

business card 10
ExpressCard 12
Media Card Reader 12
memory module 14
security cable 11
SIM 14
smart card reader 11

smart card reader
removal 68
spare part number 29, 68

smart card reader bezel,
illustrated 23

smart card reader, identifying 11
solid-state drive, spare part

numbers 22, 24, 28, 30, 41
speaker assembly

removal 60
spare part number 20, 29, 60

speakers, identifying 10
specifications

computer 85
display 86
hard drive 87

static-shielding materials 35
switches

internal display 8
power 10
wireless 12

system board
removal 70
spare part number 20
spare part numbers 70

system board shield
removal 66
spare part number 20, 29
spare part numbers 66

System Configuration menu 81
system date and time 79
system diagnostics 79
system fan 81
system IDs 80
system information 79

T
thermal material, replacement 74
tools required 31
top cover

removal 51
spare part number 19, 51
spare part numbers 28

touch screen, identifying 5
TouchPad

buttons 6
identifying 6
scroll zone 6

TouchPad light 6, 7
TouchPad on/off control 6
TPM Embedded Security 80
transporting guidelines 34
TXT (IntelTrusted Execution

Technology) 82

U
Unified Extensible Firmware

Interface (UEFI) mode 81
Universal Serial Bus (USB) port,

pin assignments 102
USB legacy support 77, 81
USB port, powered 12
USB ports, identifying 11
user management 80

V
vents, identifying 12, 14
Virtualization Technology 82
volume down button,

identifying 8
volume down light, identifying 7
volume mute button, identifying 8
volume mute light, identifying 7
volume up button, identifying 8
volume up light, identifying 8

W
webcam

identifying 5
product description 2

webcam light, identifying 5, 10
Windows 7 operating system

DVD 92
Windows applications key,

identifying 9
Windows Backup utility 96, 97
Windows logo key, identifying 9
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Windows recovery 97
Windows Vista operating system

DVD 95
wireless antennas

disconnecting 44
wireless antennas,

disconnecting 46
wireless devices, location 14
wireless light, identifying 12
wireless switch, identifying 12
wireless, product description 2
WLAN antennas, identifying 15
WLAN module

removal 43
spare part number 28, 43
spare part numbers 20

workstation guidelines 34
WWAN antenna button,

external 15
WWAN antennas, external 10, 15
WWAN antennas, identifying 15
WWAN module

removal 46
spare part number 20, 28, 46

WWAN module, spare part
number 28

ENWW Index 109


	Product description
	External component identification
	Display
	Top components
	Pointing devices
	Lights
	Buttons and switches
	Keys

	Front components
	Right-side components
	Left-side components
	Rear components
	Bottom components
	Wireless antennas (select models only)

	Illustrated parts catalog
	Service tag
	Computer major components
	Plastics Kit
	Cable Kit
	Mass storage devices
	Miscellaneous parts
	Sequential part number listing

	Removal and replacement procedures
	Preliminary replacement requirements
	Tools required
	Service considerations
	Plastic parts
	Cables and connectors
	Drive handling

	Grounding guidelines
	Electrostatic discharge damage
	Packaging and transporting guidelines
	Workstation guidelines
	Equipment guidelines



	Component replacement procedures
	Service tag
	Computer feet
	Pen
	Battery
	SIM
	Hard drive
	WLAN module
	WWAN module
	Memory modules
	Keyboard
	Top cover
	RTC battery
	Audio connector board
	Bluetooth module
	Latch assembly
	Speaker assembly
	Display assembly
	System board shield
	Modem module
	Smart card reader
	System board
	Fan/heat sink assembly
	Misc cables


	Computer Setup
	Starting Computer Setup
	Using Computer Setup
	Navigating and selecting in Computer Setup
	Restoring factory settings in Computer Setup

	Computer Setup menus
	File menu
	Security menu
	System Configuration menu


	Specifications
	Computer specifications
	30.7-cm (12.1-in), WXGA display specifications
	Hard drive specifications

	Backup and recovery
	Windows 7
	Backing up your information
	Performing a recovery
	Using the Windows recovery tools
	Using f11
	Using a Windows 7 operating system DVD (purchased separately)


	Windows Vista
	Backing up your information
	Performing a recovery
	Using the Windows recovery tools
	Using f11
	Using a Windows Vista operating system DVD (purchased separately)


	Windows XP
	Backing up your information
	Performing a recovery
	Recovering your information
	Recovering the operating system and programs



	Connector pin assignments
	1394
	Audio-out (headphone)
	Audio-in (microphone)
	External monitor
	RJ-11 (modem)
	RJ-45 (network)
	Universal Serial Bus

	Power cord set requirements
	Requirements for all countries and regions
	Requirements for specific countries and regions

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.00000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.00000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /Description <<
    /ENU <FEFF0046004f00520020004100630072006f006200610074002000360020004f004e004c0059000d0048005000490045002000530063007200650065006e0020004f007000740069006d0069007a00650064002000530065007400740069006e006700200066006f00720020004100630072006f006200610074002000360020004f004e004c0059>
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice




